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FORMATTING TEXT BY U SING STYLES

What is a style?

A style is formatting characteristics that can be applied to text in a document to quickly
change its appearance. When a style is apgied, a whole group of formats are
performed in one simple task.

Apply a style
To quickly change all the text that is formatted with a particular style, apply a different
style.

1. Select the text to apply a style to.

2. In the formatting toolbar, click the Styles drop down arrow to display styles.

3. Select a style to apply. A [TE [7]rehoma .12 .
Or el | Clear Formatting i !
= o
1. Select the text to apply a style to. Footer
. = || Header 1
2. Onthe Format menu, click Styles and - -
Formatting . ~ || Heading 1 1
3. Inthe Styles and Formatting Task Pane : Heading 2 b
on the right side of the screen, click the - |l Heading 3 1
style to apply. Z
=l Mormal 1
: More...
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Modify a style

Il f t her e -instykedvith the characteristics you prefer, you can modify the
style, and then apply it.

1. Onthe Format menu, click Style s and Formatting

Modify Style E|
Properties i

flame:

Style based on: 1 Marmal v
Stvle For Following paragraph: 1 Mormal W
Faormatting

Aial vi[ie ~|[[B| 7 Uu A-
=== = |[—]= — |+= o= | &= =
|E_ = = = = = | = 4= | T T

Sample Text Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Texdt Sample Text
Sample Text Sample Text Sample Taxt Sample Text
Sample Text Sample Text Sample Text Sample Text
Sample Text Sample Text Sample Text Sample Text
Sample Text

Mermal + Font: (Default) arial, 16 pt, Bold, Kern at 16 pt, Space
Before: 12 pt, After: 3 pt, Kesp with next, Level 1

[ ] Add to kemplate [] Automatically update
Formak ~ I (4 ] [ Cancel ]

2. Inthe Styles and Formatting Task Pane located on the right side of the
screen, select the style to modify, and then click Modify from the drop -down
menu.
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Mo dify Style E|

Properties i
[WETH Heading L |
Style based on: . 11 Mormal W |
Skyle For Following paragraph: 1 Mormal w |
Farmakking
Arial ¥ (16 & B I U ﬁ -
=l = = _ | = — pE = = =
= E=E = - — = 4= = Oi=
Font. ..
Faragraph... xt Sample Text Sample Text
xt Sample Texd Sample Test
Tabs. .. wt Sample Text Sample Test
- «t Sampla Tesd Sample Taxt
Border... w1 Sample Text Sample Tesxt
Lanquage. ..
jal, 16 pt, Bold, Kern &t 16 pt, Space
Frame... Keep with next, Level 1
Mumbering...
Shortcut kev... [] automatically update
Format ~ [ i ] [ Cancel ]

3. Click Format button on the bottom left corner of the dialog box , and then
select the attribute to be modified.

4. Make any changes.

5. Click OK when complete.

Note : Remember, all text in the document with the designated style will be
changed to the newly modified style.
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Create A Table Of Contents

A table of contents is a list of the headings in a document. Use a table of contents to
get an overview of the top ics in a document or to quickly navigate to a topic.

1. In the document, apply built -in heading styles (Heading 1 through Heading 9) to
the headings to include in the table of contents.

2. Click to place the insertion point where the table of contents will be located.

3. Onthe Insert menu, choose Reference then click Index and Tables , and
choose the Table of Contents tab.

Index and Tables E|
Irdey Tahlc-:lFEJ:-rtanS; Table of Figures | Table of Suthorities
Prick Preyiew Web Preview
Heading 1.l 1|2 | |Heading 1 5
Heading 2., 3 Heading 2
Heading 3. 5 Heading 3
W W
Show page numbers Use hyperlinks instead of page numbsars
Rioht align page rumbers
Talgleader:-....... v
General
Formats: | Fromtemplate (w0 Show lewels: |3 3
Shaw Outlning Tooloer ] [ Opticrs. .. | | Modiy. .. ]
| ok ][ cenca |

4. Select a format from the Formats drop down list and select the number of levels
to display in the Show levels area.

5. Click OK to complete the table of contents.
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ENVELOPES & LABELS

Create and Print an Envelope

1. Onthe Tools menu, choose Letters and Mailings  then click Envelopes and
Labels , and choose the Envelopes tab.

Envelopes and Labels @

Ervelopes | Lahels

Pellvery address: [F4 g ( Prirk |
.Y
[ addtoDocumert |
[ Canced ]
( Options. . |
= [ E-postage Properties. ., ]
[] Add electronic postage
Return address: 13 g ] it
Presvigw Feed
= ¥

P s

Befare printing, nsert envelooes in your printer's Auto Select,

2. Inthe Delivery address box, enter the mailing address.

3. Inthe Return addr ess box, enter the return address. To omit a return
address, select the Omit check box.

4. Do one of the following:

1 Print T to print one copy of the envelope, insert an envelope in the
printer as shown in the Feed box and click Print.

1 Add To Document 1 used to attach the envelope to the current
document for later editing or printing.

I Cancel T to cancel and return back to the document.

1 Options i to select an envelope size, the type of paper feed, and other

options.

1 E-Postage Properties 1 must have electronic postage program, such as
stamps.com, installed on computer first then this will allow you to set
options

5. Click OK when complete.
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Mailing Labels

On the Tools menu, choose Letters and Mailings  then click Envelopes and
Labels , and choose the Labels tab.

| Envelopes | | Labels ||

fiddess: W3~ [Juse peturn address l Prink |
[ .Y

[ Mew Dooument ]

[ Canced ]

( Options. . |

= [ E-postage Properties. ., ]

Label
Print Avery standard, 2160 Mini

= Full page of the same label Address

Befare printing, nsert labels in your printer's manual feeder,

1. Inthe Address box, enter or edit the address.
2. Inthe Print area, select on of the following options:

9 To print a single label, click Single label and select the row and column
number on the label sheet for the label to print on.

1 To print the same address on a sheet of labels, click Full page of the
same label .

Note: To select the label type, the type of paper feed, and other options, click
the Options button.

3. To print one or more labels, insert a sheet of labels into the printer, and then
click Print . To save a sheet of labels for later editing or printing, click New
Document .

4. Click OK when complete.

OMPLETEEXERCISEL
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MAIL MERGE FOR WORD 2000

Mail Merge is used to create form letters, mailing labels, envelopes, or catalogs. The
Mail Merge Hdper is a tool to guide you through organizing data, merging it into a
document, and printing the resulting personalized documents.

A Mail Merge for Microsoft Word 2000 on pages 9-14
A Mail Merge for Microsoft Word 2003 on pages 15-18

Step 1. Create The Main  Document

1. Create a new document.
2. Onthe Tools menu, click Mail Merge .

Mail Merge Helper

Ilse this checklist to set up a mail merge. Begin by choosing the Create
buttorn,

=
1 Main docurment

Create = i

e
2 Data source

el [ata

3
Merge the data with the documenk

Merge. ..

Cancel |

3. Under Main document , click Create , and then click Form Letters

Microsoft Word

¥ |\ Tocreate the Form letkers, wou can use the active document window word2, doc ar a
x‘_‘/ ne document windo,

Ackive Window e Main Document:

................ Prrreh e Ao A IR
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4. Click Active Window

Step 2. Create The Data Source

1. Inthe Mail Merge Helper dialog box, click Get Data.

=
1 Main docurnent

Create - | Edit -

Merge type: Form Letkers
Main document: Documentz

B
2 Data source

| GetData~ |

Create Data Source...

3 Open Data Source...
Use Address Book...

Header Options...

1 Create Data Source . Use this method if the data has not yet been
created and you want to store the data in a Word table.

1 Open Data Source . Use this method if the data is already stored in a
Microsoft Word document, a worksheet, database, or other list.

 Use Addresses Book . Use this method if the information is stored in an
electronic address book.

2. SelectCreate Data Source

Create Data Source

A mail merge data source is composed of rows of data, The First row is called the
header rowe, Each of the columns in the header row begins with a field name,

‘hord provides commonly used field names in the lisk below, You can add ar remove
field names to customize the header raw,

Remove Field Mame

Field name: Field names in header row:
Fir stMarne Ll
Add Field Mame ## | LastMarne
1obTitle Mowe
Campany Ll
| Address1

Addressz Ed

M3 QUery, .. | 0k, I Cancel I
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3. Remove any unwanted fields by first selecting the field name from the list and
clicking the Remove Field Name button.

4. Add additional fields by typing the name of the field in the Field Name box, and
clicking the Add Field Name button.

5. When finished, click OK.

Save As
Save in: I@' Desktop

@ b4 @* Tools =

= My Docurents

e
bj My Cornmpuker

Hiskary My Metwork Places

“

My Documents

Fawarites

File mame: Idatal j | E save I
Save as bype: I'u'u'n:nru:l Diocurment (*,d0c) j Cancel |

Note: You will be prompted to save the document that will hold the data. Make
sure to type a meaningful name, and save it to a location you will remember.

Microsoft Word

P The data source you just created contains no data records, You can add new records
\..’) ko ywour data source by choosing the Edit Data Source butkon, or add merge Fields ko
wolr main document by choosing the Edit Main Document bukton,

Edit Diata Source Edit Main Document |

6. SelectEdit Data Source to begin entering the address information.
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Data Form HE

Title: ﬂ oK |
FirstMarne: Add Mew |
LaskMarne: | |
JobTitle: Delete
Campany': Restare |
Address1: Find. . |
Addressz:
City: Yiew Source |
State: =
Record: Hl 4 |1 ¢ | Hl

1 Add New 1 used to create a new record

91 Delete i deletes the current record

1 Restore i used to undo changes made to the current record

1 Find T used to search the data for specific criteria

1 View Source T opens the data source document

7. Enter the first record in the fields provided, and click Add New to create a new

record.

8. Click OK when finished adding records to the data source.

Microsoft Word - Intermediate
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Step 3. Edit The Main Documen t, and Merge
the Data

In the main document, it is time to type the text that will appear in every form
letter. Once the document is prepared, insert merge fields where they would
normally be displayed on the document.

Insert Merge Field -

1. To insert a merge field, click in the main document, click
Insert Merge Field on the Mail Merge toolbar, and then

click the field name you want. Firsthiame
LastMame
Note : Make sure to include all punctuation between fields as JobTitle
needed. Company
] ) Addressl
2. Once all the merge fields have been inserted, save the P——
document by using Save As from the File menu. Name the City

document, and then click Save.

Example:

June 5, 2002

aTitlen «Firsttames «LasttNames
gbddressln
ghddressZn

wCitye, wotates sPostalCodes

Dear ¢Titler «LastMName:s,
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3. From the Tools menu, click Mail Merge

Mail Merge Helper

The main document and data source are ready ko merge. Choose the Merge
buttan ko complete the merge.

=
1 Main document

Create ™ Edit =

Merge bype: Form Letkers
Main document: Docurment?

[Fs
2 [aka source

Gek Daka ™ Edit =
Daka: i, .. \data.doc

3
Merge the data with the document

Query Opkions. .. |

Cpkions in effeck:
Suppress Blank Lines in Addresses
Merge ko new document

Cancel |

4. Click the Merge button under step 3 .

Merge HE

Merge to: | Merge

|
T — - sup | S
|
|

~Records ko be merged
4l " From: I Tao: I Check Errars. ..

Query Options. ..

—wWhen merging records
£ Don't print blank lines when data fields are empty,
€ print blank lines when data fields are empky.

Mo query aptions have been set,

5. Inthe Merge to field, choose New Document to store the merged letters in a
new document.

6. Inthe Records to be merged area, select All to merge all records.

7. ClickMerge to complete.
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MAIL MERGE FOR WORD 2003

Mail Merge is used to create form letters, mailing labels, envelopes, or catalogs. The
Mail Merge Task Pane is a tool to guide you through organizing data, merging it into a
document, and printing the resulting personalized documents.

A Mail Merge for Microsoft Word 2000 on pages 9-14
A Mail Merge for Microsoft Word 2003 on pages 15-18

Mail Merge * X

Step 1. Select document type

1. On the Tools menu, choose Letters and Mailings Select document type
i i h Fd
then click Mail Merge . e cocument ars you
(%) Letkers
2. The Mail Merge Task Pane will be on the right side () E-mail messages
of the screen and will guide us through 6 steps. O Erwelopes
() Labels
3. SelectLetters option as document type and click O Directory
on Next: Starting document link at the bottom Letters
right corner of the screen. Send letters to a group of people.

‘fou can personalize the letter that
each person receives,

Click Mext bo continue.

Step 1 of 6
& Mext: Starting docurent

Step 2: Starting document

Mail Merge v X .
4. SelectUse the current document option
®| 8| A
Select starting document 5. Click on Next: Select r ecipients link at the bottom
D O R S U L right corner of the screen.

() Use the current document
() Start from a template

() Start from existing document

Use the current document

Start From the document shown
here and use the Mail Merge wizard
to add recipient information,

Step 2 of 6
& Mext: Select recipients

@ Previous: Select document bype

Microsoft Word - Intermediate
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Step 3: Select recipients

6. SelectType a new list option and then click Create on the Mail Merge Task
Pane

7. Enter the first record in the fields provided, and click New Entry button to
create a new record.

a— . _
® New Address List rg| # | i Mail Merge -

Enter Address information A
Title || Select recipients
First Mame | () Use an existing list
Last Mame | () Select from Gutlook contacts

Company Name | (%) Tvpe a new lisk

|
|
|
|
Address Line 1 | | Type a new list
|
|
|

Address Line 2 | Type the names and addresses of
recipients,
dity |
o =] Create..,
W
e Enkry ] [ Delete Entry ] [ Find Enkry. .. ] [Filter and §0rt...] [ Customize. .. ]
Wiew Entries
Wiew Entry Mumber |:|
Tatal entries in list 1
¥| Step3of6
; & Next: Write vour letter
k4 @ Previous: Starting document
A New Entry i used to create a new record
A Delete Entry i deletes the current record
A Find Entry 1 used to search the data for specific criteria
A Filter and Sort T query record data and sorting options
A Customize 1 add, delete, or rename field names

8. When finished typing in all records click on the Close button in the bottom
corner of the New Address List dialog box

9. The Save Address List dialog Save Address List B
box will now appear. Type the Sevmin (2 My Dt Coces TELEEED
file name then click Save u:.! g Iravd detazuuree

Hy Rl

button. Your file will be saved in Documarts
the My Data Sources folder in 3

the My Documents area of Destton
the computer.

Py Ducumanis
-1
(1] iunmr
L !E Fle name: | =
by Miptwark e
Aoz St o by |'-1|:rm:ﬁ: offce addeess Lsts - Cantn
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10.Then the Mail Merge Recipients dialog box will appear for you to review all
records to be used. If you do not want a record used in the Mail Merge then click
in the check-box located in front of the listed records name. Click OK button

when finished.

Mall Merge Reciplents B|
H . To som: b bst, dakthe sopropnsce cobomn hesding, Toremore comr the recpents deplsved by 5
11 ' CIICk on NeXt spariic -'d.'rﬁ'.l_ such as by oy, dick the aemaw et i the coume heading. Wse the check boees or
H buttons to sde or reroys regmsys from the mal mearge,
Write your letter R M
I|n k at the bottom | LastMame = | SrscMame = Thke | Companyileme v AddessLl
. H | e T I
rig ht corner of the B alez Mr. %ish You iere Her... 351 Main S
B Fare Lo Hrs. ik VnuWeers Hee.. 251 Main Srest
screen = TS Laikan s, which VYnowana Her,, P51 Main Sres

£

: Bnd... jl ..,

[ ssectal | [ chesral | [ pefresh |
[ gdda= |

Step 4. Write your letter

12.Select Address block option on the Mail Merge Task

Pane

13.The Insert Address Block dialog box will appear. Select

your options and click OK button when finished.
<<AddressBlock>> code will show on your letter.

14.Then select Greeting line  option on the Mail Merge
Task Pane and choose your options from the Greeting ~ **
Line dialog box. When finished click the OK button.

<<GreetingLine>> code will show on your letter.

Note: select More items to choose specific fields to

add to your letter

15. Click on Next: Preview your letters
bottom right corner of the screen.

< Lmed e e L

rep=—
i st
v 1), Dl B

Greeling Line

L

link at the

Mail Merge b4

Write your letter

IF wou have not already done so,
write wour letker now,

To add recipient information to
wour letter, dick a location in the
document, and then click one of
the items below,

=] Address block...

= Greeting line...

j Electronic postage. ..
Il Pastal bar code...
=] Mare items. .,

‘when vou have Finished writing
wour letker, dlick Mext, Then wou
can preview and personalize each
recipient's letter,

Step 4 of B
% NMext: Preview your letters

@ Previous: Seleck recipients

foryae ik tha 2oy g ks sk
D e e e
vaake gl

[ Pormal a b, s L B e v i
i

i eating lins hamisk:

= *| Fr Raisd | |, |
i3 main g e fae neeslld redislank nares

Oz 5o Medam, w

Fra-iap

Do W, Ronda |

Hatrk Fwrh .
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Step 5. Preview your letters

16.The Address Block and Greeting Line fields will now display previews ofrecipients

from your data source.

17.Use the record selector buttons << and >> to flip
through preview of recipients in your letter. Use the
Exclude this recipient  button if you do not want the
previewed recipient to be included with the Mail Merge.

18.Click on Next: Complete the merge link at the b ottom
right corner of the screen.

Step 6. Complete the merge

19.Complete the merge with the options located on the Mall
Merge Task Pane.

A Print i prints letters addressed to all recipients
A Edit individual letters T merges all recipients data to
letters for editing in Microsoft Word

COMPLETEEXERCISE2
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